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Preface

INTRODUCTION

This chapter contains general information that will be useful to know before using the 

MCP19111 PMBus™ Protocol-Enabled Point-of-Load Converter Reference Design. 

Items discussed in this chapter include:

� Document Layout

� Conventions Used in this Guide

� Warranty Registration

� Recommended Reading

� The Microchip Web Site

� Development Systems Customer Change Notification Service

� Customer Support

� Revision History
I

NOTICE TO CUSTOMERS

All documentation becomes dated, and this manual is no exception. Microchip tools and 

documentation are constantly evolving to meet customer needs, so some actual dialogs 

and/or tool descriptions may differ from those in this document. Please refer to our web site 

(www.microchip.com) to obtain the latest documentation available.

Documents are identified with a “DS” number. This number is located on the bottom of each 

page, in front of the page number. The numbering convention for the DS number is 

“DSXXXXXXXXA”, where “XXXXXXXX” is the document number and “A” is the revision level 

of the document.

For the most up-to-date information on development tools, see the MPLAB® IDE online help. 

Select the Help menu, and then Topics to open a list of available online help files.

WARNING

The present reference design is intended to be used only to prove the MCP19111 

functionality and performance, solely in a laboratory environment. Microchip 

Technology Inc. assumes no liability for any damage resulting from using the present 

reference design in other purposes.
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DOCUMENT LAYOUT

This document describes how to use the MCP19111 PMBus™ Protocol-Enabled 

Point-of-Load Converter Reference Design as a development tool to emulate and 

debug firmware on a target board, as well as how to program devices. The document 

is organized as follows:

� Chapter 1. “Product Overview” – Important information about the MCP19111 

PMBus™ Protocol-Enabled Point-of-Load Converter Reference Design.

� Chapter 2. “Installation and Operation” – Includes instructions on how to get 

started using the MCP19111 PMBus™ Protocol-Enabled Point-of-Load Converter 

Reference Design.

� Chapter 3. “Calibration Procedure” – Includes instructions on the calibration 

procedure of the MCP19111 PMBus™ Protocol-Enabled Point-of-Load Converter 

Reference Design.

� Chapter 4. “Typical Performance Data, Curves and Waveforms” – Includes 

typical performance graphs of data, curves and waveforms.

� Appendix A. “Schematics and Layouts” – Shows the schematic and layout 

diagrams for the MCP19111 PMBus™ Protocol-Enabled Point-of-Load Converter 

Reference Design.

� Appendix B. “Bill of Materials (BOM)” – Lists the parts used to build the 

MCP19111 PMBus™ Protocol-Enabled Point-of-Load Converter Reference 

Design.

� Appendix C. “Calibration Example” – Gives an example of a calibration 

procedure for the MCP19111 PMBus™ Protocol-Enabled Point-of-Load Converter 

Reference Design.
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CONVENTIONS USED IN THIS GUIDE

This manual uses the following documentation conventions:

DOCUMENTATION CONVENTIONS

Description Represents Examples

Arial font:

Italic characters Referenced books MPLAB® IDE User’s Guide

Emphasized text ...is the only compiler...

Initial caps A window the Output window

A dialog the Settings dialog

A menu selection select Enable Programmer

Quotes A field name in a window or 

dialog

“Save project before build”

Underlined, italic text with 

right angle bracket

A menu path File>Save

Bold characters A dialog button Click OK

A tab Click the Power tab

N‘Rnnnn A number in verilog format, 

where N is the total number of 

digits, R is the radix and n is a 

digit.

4‘b0010, 2‘hF1

Text in angle brackets < > A key on the keyboard Press <Enter>, <F1>

Courier New font:

Plain Courier New Sample source code #define START

Filenames autoexec.bat

File paths c:\mcc18\h

Keywords _asm, _endasm, static

Command-line options -Opa+, -Opa-

Bit values 0, 1

Constants 0xFF, ‘A’

Italic Courier New A variable argument file.o, where file can be 

any valid filename

Square brackets [ ] Optional arguments mcc18 [options] file 
[options]

Curly brackets and pipe 

character: { | }

Choice of mutually exclusive 

arguments; an OR selection

errorlevel {0|1}

Ellipses... Replaces repeated text var_name [, 
var_name...]

Represents code supplied by 

user

void main (void)
{ ...
}
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WARRANTY REGISTRATION

Please complete the enclosed Warranty Registration Card and mail it promptly. 

Sending in the Warranty Registration Card entitles users to receive new product 

updates. Interim software releases are available at the Microchip web site.

RECOMMENDED READING

This user’s guide describes how to use MCP19111 PMBus™ Protocol-Enabled 

Point-of-Load Converter Reference Design. Other useful documents are listed below. 

The following Microchip documents are available and recommended as supplemental 

reference resources.

MCP19110/11 Data Sheet (DS20002331)

This data sheet describes the operation and features of the MCP19110/11 

digitally-enhanced power analog controller with integrated synchronous driver.

PMBus™ Monitoring Graphical User Interface User’s Guide (DS50002380)

This user’s guide describes how to use the PMBus Monitoring Graphical 

User Interface (GUI).

TB3139, MCP19111 PMBus™ Firmware Technical Brief (DS90003139)

This technical brief describes how to use the MCP19111 PMBus firmware.

THE MICROCHIP WEB SITE

Microchip provides online support via our web site at www.microchip.com. This web 

site is used as a means to make files and information easily available to customers. 

Accessible by using your favorite Internet browser, the web site contains the following 

information:

� Product Support – Data sheets and errata, application notes and sample 

programs, design resources, user’s guides and hardware support documents, 

latest software releases and archived software

� General Technical Support – Frequently Asked Questions (FAQs), technical 

support requests, online discussion groups, Microchip consultant program 

member listing

� Business of Microchip – Product selector and ordering guides, latest Microchip 

press releases, listing of seminars and events, listings of Microchip sales offices, 

distributors and factory representatives
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DEVELOPMENT SYSTEMS CUSTOMER CHANGE NOTIFICATION SERVICE

Microchip’s customer notification service helps keep customers current on Microchip 

products. Subscribers will receive e-mail notification whenever there are changes, 

updates, revisions or errata related to a specified product family or development tool of 

interest.

To register, access the Microchip web site at www.microchip.com, click on Customer 

Change Notification and follow the registration instructions.

The Development Systems product group categories are:

� Compilers – The latest information on Microchip C compilers, assemblers, linkers 

and other language tools. These include all MPLAB® C compilers; all MPLAB 

assemblers (including MPASM™ Assembler); all MPLAB linkers (including 

MPLINK™ Object Linker); and all MPLAB librarians (including MPLIB™ Object 

Librarian).

� Emulators – The latest information on Microchip in-circuit emulators.This 

includes the MPLAB REAL ICE™ and MPLAB ICE 2000 In-Circuit Emulators.

� In-Circuit Debuggers – The latest information on the Microchip in-circuit 

debuggers. This includes MPLAB ICD 3 In-Circuit debugger and PICkit™ 3 

Debug Express.

� MPLAB® IDE – The latest information on Microchip MPLAB IDE, the Windows® 

Integrated Development Environment for development systems tools. This list is 

focused on the MPLAB IDE, MPLAB IDE Project Manager, MPLAB Editor and 

MPLAB SIM Simulator, as well as general editing and debugging features.

� Programmers – The latest information on Microchip programmers. These include 

production programmers, such as MPLAB REAL ICE In-Circuit Emulator, MPLAB 

ICD 3 In-Circuit Debugger and MPLAB PM3 Device Programmer.

CUSTOMER SUPPORT

Users of Microchip products can receive assistance through several channels:

� Distributor or Representative

� Local Sales Office

� Field Application Engineer (FAE)

� Technical Support

Customers should contact their distributor, representative or field application engineer 

(FAE) for support. Local sales offices are also available to help customers. A listing of 

sales offices and locations is included in the back of this document.

Technical support is available through the web site at: 

http://www.microchip.com/support

MCP19111 PMBUS-ENABLED POL CONVERTER REFERENCE DESIGN LICENSE

Copyright © 2015 Microchip Technology Inc. All rights reserved.

1. License Grant. Microchip licenses to you the right to use this reference design 

and all related documentation (“Reference Design Materials”) for purposes of 

developing your application using Microchip products. You may not re-distribute 

Reference Design Materials to any third parties.

2. Warranty Disclaimer. Reference Design Materials are provided for your conve-

nience only and may be superseded by updates. These materials will not be 

deemed to modify Microchip’s standard warranty for its products. It is your 

responsibility to: (1) ensure that the Reference Design Materials, and your use 

thereof, meet your requirements; and (2) test your application.
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REFERENCE DESIGN MATERIALS ARE PROVIDED “AS IS” WITHOUT 

WARRANTY OF ANY KIND, EITHER EXPRESS OR IMPLIED, INCLUDING 

WITHOUT LIMITATION, ANY WARRANTY OF MERCHANTABILITY, TITLE, 

NON-INFRINGEMENT AND FITNESS FOR A PARTICULAR PURPOSE.

3. Limit on Liability. IN NO EVENT WILL MICROCHIP BE LIABLE OR 

OBLIGATED UNDER CONTRACT, NEGLIGENCE, STRICT LIABILITY, 

CONTRIBUTION, BREACH OF WARRANTY, OR OTHER LEGAL EQUITABLE 

THEORY ANY DIRECT OR INDIRECT DAMAGES OR EXPENSES INCLUDING 

BUT NOT LIMITED TO ANY INCIDENTAL, SPECIAL, OR CONSEQUENTIAL 

DAMAGES, LOST PROFITS OR LOST DATA, COST OF PROCUREMENT OF 

SUBSTITUTE GOODS, TECHNOLOGY, SERVICES, ANY CLAIMS BY THIRD 

PARTIES (INCLUDING BUT NOT LIMITED TO ANY DEFENSE THEREOF), OR 

OTHER SIMILAR COSTS. MICROCHIP DISCLAIMS ALL LIABILITY ARISING 

FROM THIS INFORMATION AND ITS USE. USE OF MICROCHIP DEVICES IN 

LIFE SUPPORT AND/OR SAFETY APPLICATIONS IS ENTIRELY AT THE 

BUYER’S RISK, AND THE BUYER AGREES TO DEFEND, INDEMNIFY AND 

HOLD HARMLESS MICROCHIP FROM ANY AND ALL DAMAGES, CLAIMS, 

SUITS, OR EXPENSES RESULTING FROM SUCH USE.

TO THE FULLEST EXTENT PERMITTED BY LAW, MICROCHIP’S LIABILITY IS 

CAPPED AT THE AMOUNT YOU PAID DIRECTLY TO MICROCHIP FOR THESE 

REFRENCE DESIGN MATERIALS.

4. Governing Law. THIS LICENSE WILL BE GOVERNED BY AND 

CONSTRUCTED UNDER THE LAWS OF THE STATE OF ARIZONA AND THE 

UNITED STATES WITHOUT REGARD TO CONFLICTS OF LAWS PROVISIONS. 

Licensee agrees that any disputes arising out of or related to this License, Software 

or Reference Design Materials will be brought in the courts of State of Arizona. The 

parties agree to waive their rights to a jury trial in actions relating to this License.     

REVISION HISTORY

Revision A (June 2015)

This is the initial release of this document.
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Chapter 1.  Product Overview

1.1 INTRODUCTION

This chapter provides an overview of the MCP19111 PMBus™ Protocol-Enabled 

Point-of-Load Converter Reference Design and covers the following topics:

� MCP19111 Device Short Overview

� What is the MCP19111 PMBus™ Protocol-Enabled Point-of-Load Converter 

Reference Design?

� What the MCP19111 PMBus™ Protocol-Enabled Point-of-Load Converter 

Reference Design Kit Contains?

1.2 MCP19111 DEVICE SHORT OVERVIEW

The MCP19111 device is a highly integrated, mixed signal, Analog Pulse-Width 

Modulation (PWM) Current mode controller with an integrated microcontroller core for 

synchronous DC/DC step-down applications. Since the MCP19111 uses traditional 

analog control circuitry to regulate the output of the DC/DC converter, the integration of 

the PIC® microcontroller mid-range core is used to provide complete customization of 

the device operating parameters, start-up and shutdown profiles, protection levels and 

Fault handling procedures.

The MCP19111 is designed to efficiently operate from a single, 4.5V to 32V supply. It 

features integrated synchronous drivers, a bootstrap device, internal linear regulator and 

4000 words of nonvolatile memory, all in a space-saving, 28-pin 5 mm x 5 mm QFN 

package.

PMBus™ or I2C™ can be used by a host to communicate with, or modify the operation of, 

the MCP19111. A subset of the commands contained in the “PMBus™ Power System 

Management Protocol Specification, Revision 1.1” are supported by the ARD00609 board.

An internal 5V rail provides power to the PIC MCU and is also present on the VDD pin.

It is recommended that a 1 μF capacitor be placed between VDD and PGND. The VDD 

pin may also be directly connected to the VDR pin or connected through a low-pass 

RC filter. The VDR pin provides power to the internal synchronous driver. 

NOTICE TO CUSTOMERS

The present reference design is intended to be used only to prove the MCP19111 functionality 

and performance, solely in laboratory environment. Microchip Technology Inc. assumes no 

liability for any damage resulting from using the present reference design in other purposes.

CAUTION

All the functionalities described in this document are specific to the original firmware 

loaded in the MCP19111. Once the user software is loaded, the PMBus communication 

and board settings become the user’s responsibility.
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FIGURE 1-1: MCP19111 Typical Application.
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1.3 WHAT IS THE MCP19111 PMBus™ PROTOCOL-ENABLED POINT-OF-LOAD 
CONVERTER REFERENCE DESIGN?

The MCP19111 PMBus™ Protocol-Enabled Point-of-Load Converter Reference 

Design demonstrates how the MCP19111 device operates in a synchronous buck 

topology over a wide input voltage and load range. Nearly all operational and control 

system parameters are programmable by utilizing the integrated PIC microcontroller. 

For precise measurements of the output current, a precision op amp (MCP6061) and 

an inductor temperature sensor (MCP9700) are provided. The output current may be 

measured and calibrated using an internal or external op amp. The temperature 

compensation may be performed by temperature measurement or by second order 

polynomial approximation.

The PMBus Monitoring Graphical User Interface (GUI) can be used to program the 

functioning parameters and to check the operational status. To simplify the connection, 

a USB to PMBus converter is implemented on board, allowing a standard interface to 

any Windows® computer.

Alternatively, the user can program the MCP19111 using self-developed firmware (see 

Section 1.4.1 “The Development System’s Components”), tailoring it to the 

application.

The evaluation board contains headers for In-Circuit Serial Programming™ (ICSP™) 

as well as I2C and mini-USB communication, pull-up and pull-down resistor pads and 

test point pads on each GPIO pin, and a push button for system development. The 

MCP19111 PMBus™ Protocol-Enabled Point-of-Load Converter Reference Design is 

also intended to demonstrate an optimized Printed Circuit Board (PCB) layout that 

minimizes parasitics, while increasing efficiency and power density.

Proper PCB layout is critical to achieve optimum MCP19111 operation, as well as 

power train efficiency and noise minimization.

1.4 SYSTEM REQUIREMENTS

To operate the board, the following tools are required:

� Microsoft® .NET Framework 4.5 or higher

� PMBus Monitoring Graphical User Interface: This graphical user interface allows 

monitoring and changing input and output parameters for any device that has an 

incorporated PMBus™ protocol. For installation, operation and other system 

requirements, see the “PMBus™ Monitoring Graphical User Interface User’s 

Guide” (DS50002380).

WARNING

Any changes in the Settings tab from the Developer menu may result in system 

instability and/or permanent damage of the board, and is the user’s sole responsibility 

to take the necessary precautions. 
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1.4.1 The Development System’s Components

To redevelop the board firmware, the following may be required:

� MCP19111 MPLAB® X IDE Graphical User Interface Plug-In: This graphical user 

interface simplifies the configuration of the MCP19111. It is user-installed and 

resides within the MPLAB X IDE. The “MCP19110/11/18/19 – Buck Power Supply 

Graphical User Interface User’s Guide” (DS50002113) describes the plug-in 

installation procedure, as well as how to use it.

� MPLAB® X Integrated Development Environment (IDE): This is a complete 

software development environment that links the software and hardware 

development. This is a free tool, available from Microchip, that supports device 

configuration, advanced programming, as well as debug support. The GUI resides 

inside the MPLAB X IDE.

� MPLAB® XC8 Compiler: The firmware described above is coded in C and thus 

requires a C compiler. C compilers are available for free from Microchip’s 

web site.

� Configuration tools:

- PICkit™ Serial Analyzer: This communication tool may be used to configure 

the evaluation board. The PICkit Serial Analyzer is recommended and is 

available for purchase on microchipDIRECT.

- PICkit 3 In-Circuit Debugger/Programmer: A programming tool is required to 

reprogram the evaluation board. The PICkit 3 or MPLAB ICD 3 is 

recommended and they are available for purchase on microchipDIRECT.

- Any other user-preferred I2C connection for further board development.

To resume the original functionality of the ARD00609, the user can download the 

00609_RevA1.hex file from Microchip’s web site and upload it in the MCP19111 using 

a PICkit 3 In-Circuit Debugger/Programmer.

1.5 WHAT THE MCP19111 PMBus™ PROTOCOL-ENABLED POINT-OF-LOAD 
CONVERTER REFERENCE DESIGN KIT CONTAINS?

This MCP19111 PMBus™ Protocol-Enabled Point-of-Load Converter Reference 

Design kit includes the following items:

� MCP19111 PMBus™ Protocol-Enabled Point-of-Load Converter Reference 

Design board (ARD00609)

� Important Information Sheet
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Chapter 2.  Installation and Operation

2.1 BOARD FEATURES

The MCP19111 PMBus™ Protocol-Enabled Point-of-Load Converter Reference 

Design was developed to provide a compact, low-cost and highly efficient step-down 

conversion for low-to-medium output currents. 

The key features of this board include:

� Input Voltage Range: 8V to 14V

� Output Voltage: 1.2V (can be adjusted by software from 0.1 to 3.6V)

� Maximum Output Current: 20A

� 88% Typical Efficiency at 1.2V/15A output and 12V input

� 500 kHz Switching Frequency (can be software adjusted from 100 kHz to 

1.6 MHz)

� On-Board High-Performance Power MOSFET Transistors

� Overcurrent and Overtemperature Protection

� Status Report (including errors, input voltage, output voltage and current) via the 

PMBus Communication Protocol

� Precision Op Amp for Accurate Output Current Measurement

� Inductor Temperature Sensor

� Calibration of Output Voltage

� Calibration of Output Voltage and Output Current Measurements (via PMBus)

� Undervoltage Lockout (UVLO) with Programmable (via software) Thresholds

� Output Overvoltage, Undervoltage and Overcurrent Lockout, Programmable via 

Software

� For Advanced Users (use with caution): Control Loop Parameters and MOSFET’s 

Switching Dead Time can also be Adjusted by Software.
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2.2 GETTING STARTED

The MCP19111 PMBus™ Protocol-Enabled Point-of-Load Converter Reference 

Design is fully assembled and tested to evaluate and demonstrate the MCP19111 

capabilities.

2.2.1 Necessary Instruments and Tools

� Adjustable DC Power Supply with 0V-15V/5 ADC Range Output Capability

� Electronic Load with at least 25A Current Capability and Load Stepping Capability 

� Digital Oscilloscope with a Minimum Bandwidth of 50 MHz

� Digital Voltmeter/Ammeter

� Optionally, a Network Analyzer/Bode Plot Analyzer for Control Loop Analyzing

� PC with PMBMonitor GUI Pre-Installed

� USB-A to mini-USB Cable

� Wires for Connections, Capable to Sustain High Currents:

- 5A for the connection between the adjustable DC power supply and board

- 20A for the connection between the board and the electronic load

2.2.2 Setup Procedure

To power-up the MCP19111 PMBus™ Protocol-Enabled Point-of-Load Converter 

Reference Design, the following steps must be completed:

1. Connect the electronic load to the J2 connector of the demo board; the Positive 

(+) and Negative (–) connector pins are marked on the board silkscreen.

2. Connect the adjustable DC power supply to the J1 connector of the demo board; 

the Positive (+) and Negative (–) connector pins are marked on the board 

silkscreen.

3. Supply 12V from the adjustable power source.

4. Connect the test board to a PC with the PMBMonitor GUI pre-installed via a 

USB-A to mini-USB cable (J3 connector).

5. After powering up, press the push button, BT1, to turn on the output voltage. 

Alternatively, the output may be turned on from the PMBMonitor GUI ON button 

(under Status>Operation Panel).

6. The board is factory set to deliver 1.2V at 20A maximum, with the loop adjusted 

for optimum performance and current measurement performed via the auxiliary 

op amp. If different settings are desired, changes may be performed in 

several ways:

- Via the PMBus to USB on-board interface – refer to the “PMBus™ 

Monitoring Graphical User Interface User’s Guide” (DS50002380) 

for details.

- Via PMBus – the user must connect a PMBus master via the I2C interface 

of the board, connector J1.

- By user-developed software that may be loaded into the MCP19111 

J2 connector using PICkit™ 3 or another suitable programming tool.
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2.2.3 Board Testing

The typical testing setup is depicted in Figure 2-1. Table 2-1 shows all the available test 

points on the board. Table 2-2 describes the ICP/I2C communication pins’ function. 

PROG on the J2 connector is used with the PICkit 3 in-circuit programmer/debugger.

The user can connect various instruments at the listed test points to evaluate the 

parameters of the converter. The typical performance data, curves and waveforms are 

presented in Chapter 4. “Typical Performance Data, Curves and Waveforms”.

FIGURE 2-1: Typical Test Setup.
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TABLE 2-1: TEST POINT DESCRIPTION

Test Point Name Description

TP1 GPA0 Connects to GPA0 or Analog Test Output (Note 1)

TP2 GPB1 Connects to GPB1 (Note 1)

TP3 GPB7 By Default, used as Power-on Signal (connected to BT1) (Note 1)

TP4 GPA1 Connects to GPA1 (Note 1)

TP5 GPB2 By Default, used for Inductor Temperature Measurement (Note 1)

TP10 GPB6 Connects to GPB6 (Note 1)

TP12 GPB0/SDA Connects to GPB0/SDA (Note 1)

TP14 GPA7/SCL Connects to GPA7/SCL (Note 1)

TP16 VIN Input Voltage

TP17, TP41 GND Power GND

TP18 CH A Injection Point for Loop Measurement

TP30, TP31, TP32, 

TP33, TP34, TP35

SGND Signal GND

TP35 GPA3 By Default, used as External Current Measurement Input (Note 1)

TP40 VOUT Output Voltage and Channel B Injection Point for Loop Measurement 

Note 1: For a detailed description of the port pin functions, see the “MCP19110/11 Data Sheet”.

TABLE 2-2: ICP/I2C™ COMMUNICATION CONNECTOR J1 PINS

Pin Number Description

1 Do not connect

2 Do not connect

3 GND

4 SCL

5 SDA

6 GND

Note: Communication over the USB interface uses the same I2C bus; normally, 

the user should not simultaneously connect the USB and the ICP/I2C 

interfaces.
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Chapter 3.  Calibration Procedure

3.1 INTRODUCTION

In order to increase the accuracy of the output voltage setting, output voltage 

measurement and output current reading, a calibration procedure must be performed. 

It is recommended to use the Microchip dedicated PMBMonitor GUI that can be 

downloaded from the board’s web page, as it performs all needed computations and 

greatly simplifies the procedures.

For more information on the mathematical basis and implementation of the calibration 

procedures, refer to the Appendix C. “Calibration Example”.

Figure 3-1 shows the PMBMonitor GUI Interface Calibration tab. It also identifies the 

main panels used in the calibration procedures described in this chapter.

For more information on the Installation and Operation of the PMBMonitor GUI, refer to 

the “PMBus™ Monitoring Graphical User Interface User’s Guide” (DS50002380).

FIGURE 3-1: PMBMonitor GUI – Calibration Tab.
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3.2 VOLTAGE CALIBRATION

Follow these steps to perform the voltage calibration procedure:

1. Select Developer from the PMBMonitor GUI main menu, then choose the 

Calibration tab.

2. In the VOUT Settings Panel, press the Read button.

FIGURE 3-2: VOUT Settings Panel Description.

3. On the board, measure with an accurate voltmeter the output voltage between 

the TP41 and TP40 test points.

4. Input the value obtained in Step 3 in the “Measured” field, then press the Send 

button to update the data on the board.

5. Verify that both the output voltage (measured with the voltmeter) and the 

PMBMonitor transmitted value that appears on the screen are correct.

6. Go to the Status menu, and in the Operation Panel, press the StoreALL button 

to keep the actual value after power-off.

FIGURE 3-3: Status Menu – Operation Panel.
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3.3 CURRENT CALIBRATION WITH INDUCTOR TEMPERATURE 
MEASUREMENT

1. Select Developer from the PMBMonitor GUI main menu, then choose the 

Calibration tab. 

2. Choose a low test current (except zero, for example, 1A) and write the value in 

the first “Current” field in the IOUT Settings Panel. Set this current on the external 

load as accurate as possible. Press the corresponding Read button. A value will 

appear in the corresponding “Voltage” field.

FIGURE 3-4: IOUT Settings Panel.

3. Choose a high test current (at best, the highest load current, for example, 17A), 

write the value in the second “Current” field and set this output current on the 

external load. Press the corresponding Read button. Write down the value that 

appears in the second “Voltage” field.

4. Press the Calculate button. The values in the “ADC(T0)”, “Coefficient-X1” and 

“Coefficient-X0” fields may update once the calculations are done.

5. Press Send from the bottom of the IOUT Settings Panel.
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Test Current

Input the High 
Test Current

Updateable Values 
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Calculate Button
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of the Temperature 
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WARNING

Keep constant board temperature around ambient during Steps 2 to 5; therefore, all 

these measurements should be done as fast as possible and/or provide adequate 

cooling.
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Steps 6-12 are used to calibrate the temperature coefficient. Note that these steps 

apply only when a different inductor and/or layout is used.

6. Write down the T0 value from the “ADC(T0)” field.

7. Maintain the high-current output and allow the board to heat up (70-80°C is the 

optimum).

8. Press the high-current corresponding Read button and the Calculate button to 

update the values. Remember the updated value of the second voltage.

9. Compute the difference between the high-current voltage obtained in Step 8 and 

the one written down (see Step 3).

10. Compute the difference between the T0 value updated on Step 8 and the one 

written down (see Step 6).

11. Compute  as the voltage difference, divided by the last second voltage value, 

divided again by the T0 difference (see example in Equation C-5) 

(  Step 9:Step 8:Step 10). Multiply the  value by 16384; write the rounded to 

next integer value of the result in the “ALPHA” field and press the corresponding 

Send button at the right.

12. Go to the Status menu, and in the Operation Panel, press the StoreALL button 

to preserve the actual value after power-off.
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Chapter 4.  Typical Performance Data, Curves and Waveforms

This chapter shows examples of the parameters used for converter and performance 

curves, and waveforms.

 

FIGURE 4-1: Efficiency.

TABLE 4-1: CONVERTER PARAMETERS

Parameter Value Comments

Input Voltage Range (V) 8-14 —

Output Voltage (V) 1.2 ±2.5% Tolerance

Maximum Output Current (A) 20 Steady-State Output Current

Output Voltage Ripple (mV) <30 VIN = 12V, IOUT = 20A

Input Voltage Ripple (mV) <400 VIN = 12V, IOUT = 20A

Output Voltage Overshoot during Step Load (mV) <30 Step Load 5A to 15A

Switching Frequency (kHz) Typical 570 kHz —
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